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Ask I.T.  
Word 2007 
Level 1 
 
Course Objectives 

¶ Create and Save Word documents 

¶ Format text, paragraphs and pages 

¶ Understand and perform editing 
techniques  
(including cut, copy and paste) 

¶ Print documents 

¶ Use tools to automate Word 

¶ Access online Help 
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Getting Started 

 

Double click on the Word 2007 icon to start your Word Processing session. 

Screen Overview 

 
 

 The Office Button 
This icon replaces the traditional File menu.  It is the control centre for 
most commonly used tasks. 

 Quick Access Bar Always visible and provides access to tools on Office Button. 

 Ribbon  
Replaces the Menu Bar and offers a tabbed visual reference to all 
tools available in Word.  

 Status Bar Now offers a customised option to add and remove status items 

 File View  
Repositioned to right hand side and new magnification option via 
slider. 
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Microsoft Office Button 
The File menu has been replaced in with the Microsoft Office Button.  
Click this button, in the upper-left corner of the program window, to get the basic commands 
necessary to open, save, and print your documents. 

Opening a New Document 

When you start a Word session a new 
document called Document 1 is already 
active.  At any other time, to start a new 
document:  

¶ Click the Microsoft Office Button  

¶ Click on New 

¶ Select the new document you want 

¶ Click on Create 
 

Opening an Existing Document 

If you have to retrieve a file from a storage 
source: 

¶ Click the Microsoft Office Button  

¶ Click on Open 

¶ Browse to the location of your file 

¶ Select the existing document you 
want 

¶ Click on Open 
 
If you have recently used a file: 

¶ Click the Microsoft Office Button  

¶ Recently used files will be presented 

¶ Click on the file you want  
 

Saving and Closing Documents 

To save a new document 

¶ Click the Microsoft Office Button  

¶ Click on Save As 

¶ Select the format of the document  

¶ Select the location for the document 

¶ Enter a filename for the document 
(Maximum 255 characters) 

¶ Click on Save 

To close a document 

¶ Click the Microsoft Office Button  
Click on Close 
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Exercise 1.  Open an existing document  

Download “Word2007_WordLevel1Letter.docx” from: 
http://www.library.uq.edu.au/ask-it/computing-training/exercise-materials  
 

1. Click on Office Button 
2. Click on Open 
3. Browse to the location of your file 
4. Select the document you want 
5. Click on Open 

 

Exercise 2.  Adding the date  

Replace the text [ENTER DATE] with a date that updates automatically when you open the 
document. 

1. Delete the text [ENTER DATE] 
 

 

Using the Ribbon 
2. On the Insert Tab  

3. Select   
 
 
To enter date as a date stamp 

1. Select the appropriate date format   
2. Click on OK 

 
To enter date as a „Field Code 

1. Select the appropriate date format   
2. Select the “update Automatically” 

option 
3. Click on OK  

 
To update the date: 

1. Right click on the date 
2. Select Update field from the 

context menu 
 

 

http://www.library.uq.edu.au/ask-it/computing-training/exercise-materials
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Editing Information 

Selection Techniques 

Text Selection In Document In Selection Bar 

Any amount of text. Click and drag.  

A word. Double-click  

A line. Click and drag Single Click 

A sentence. Click and drag  

A paragraph. Triple Click Double Click 

An entire document. Ctrl+A Triple Click 

A section of text 1. Define a starting point-(Click at the start of the text you want to select) 

2. Move the mouse cursor to the end of the text you wish to select 
3. Define the ending point-(Hold the Shift key and click with the mouse) 

Typing Replaces Selection 

Typing replaces Selection is a feature available in Word which allows users to replace 
specific pieces of text with alternative text. 
 

1.  Selection 
 

2.  Typing 
 

3.  Completion 
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Formatting Information 
Microsoft formats text by using a very simple principle –  

“Select the text you want to change and then apply the changes to it.” 
 

   
 

Exercise 3.  Formatting text 

When formatting text, Live Preview allows you to preview the formats before applying them 

Select “Book Borrowing requirement” from Exercise 1 

 

 
Using the ribbon, change: 

 Font 

Book Borrowing requirement 

Font Size 

Book Borrowing requirement 

 Colour and Effects 

 Book Borrowing requirement 

Change the background 
Book Borrowing requirement 
 

Add a border 

Book Borrowing requirement 

  
 
 
 

Using dialog boxes, change:  
(Display dialogue box using Ctrl+D  or click on the Dialog Box Launcher) 
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Font,   
Font Size  
Colour and Effects 

 
Change the background,  
Add a border 
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Exercise 4. Using the „Format Painter‟ Tool 

A high-speed formatting option is Format Painter. This is a quick way of duplicating 
formatting from one section of text to another. 
 
To use the Format Painter once 

1. Place the cursor in the text whose format you want to copy  

2. Click the Format Painter button.  
Note: You will see a paintbrush attached to the mouse 

3. Select the text that you want to paint on the new format.  
 
To use the Format Painter repeatedly 

1. Place the cursor in the text whose format you want to copy  

2. Double-Click the Format Painter button.  
Note: You will see a paintbrush attached to the mouse 

3. Select the text that you want to paint on the new format.  
4. Click on the Format Painter button to switch off  

 

Exercise 5.  Inserting Page Breaks 

To start typing on a new page when you are ready you can automatically move to a new 
page by inserting a page break.  This can be carried out via the keyboard or the ribbon. 
 
Using the keyboard  

¶ Press Ctrl + Enter 
 
Using the Ribbon 

¶ Click on Insert tab 

¶ Click on Page Break. 
  

 
 
Viewing Non-Printing Characters 
To allow for editing of your document it is often useful to see when a page break, tab 
character or space was inserted. These are generally considered as non-printing characters 
as they don‟t print out but you can see them in the document by switching them on. 
 
To view Non-Printing Characters  

¶ On the Home Tab 

¶ Click on Show/Hide button in the ribbon  
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Spell check & Proof reading 

Exercise 6.  Spell check the whole document   

The spell check will begin from the insertion point.  It is recommended you move to the 
beginning of the document before commencing. 
 
On the Ribbon 

¶ Click on the Review Tab 

¶ Click on Spelling & Grammar  

¶ You are presented with the spell check 
dialogue box.   

 
 

 
Any spelling error is presented in red and may have alternative suggestions listed. 
 
To leave a spelling error 

¶ Click on Ignore Once or Ignore All 
 
To ensure text isn‟t picked up as an error in 
future 

¶ Click on Add to Dictionary 
To Change a spelling error 

¶ Select the correct suggestion 

¶ Click on Change or Change All 
 

 
 

Any grammar error is presented in green and may have alternative suggestions listed. 
To leave a grammar error 

¶ Click on Ignore Once, Ignore Rule or 
Next Sentence 

 
To change a grammar error 

¶ Select the correct suggestion 

¶ Click on Change  
 
To find out more about an error  

¶ Click on Explain 
 

 

Checking Individual errors 

In the status bar the spelling indicator will display a red cross to indicate there are errors in 
the document. 
To go to the closest error in the document 

¶ Click on the spell check icon   

Cut, Copy & Paste techniques 
When using cut & copy techniques, the information selected is temporarily placed on the 
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clipboard for use in another location.  This can be either in the same document, in a 
completely different document or even in a different type of file.   
Providing you have the clipboard task pane open, you can collect 24 separate items on the 
clipboard and paste any one of these when required.  This information is stored during your 
active session but is cleared when you log off.   
 
 
To open the Clipboard Task Pane: 

¶ Click on the Dialogue box expander 
 
 

 

Exercise 7.  Copy & Paste Techniques 

Open a new document for this exercise: 
Your Name  
Job Title 
Department 
Institution 

 
 

Celebrity 
Profession 

 

 

Using the Ribbon 

(Via the clipboard – useful between other documents and other applications) 
To Move text 

¶ Select the text you want to move. 

¶ Click on the scissors icon on the Ribbon  

¶ Go to the new location for the selected text  

¶ Click the Paste icon 
 
To Copy text 

¶ Select the text you want to copy. 

¶ Click on the double document icon on the Ribbon  

¶ Go to the new location for the selected text  

¶ Click the Paste icon 
 

Using the Mouse 

(the Drag and Drop technique - useful within one document) 
To Move text 

¶ Select the text you want to move. 

¶ Click on the selection 

¶ Drag to the new location for the selected text  
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(Note: you will see a document icon attached to the mouse) 
¶ Release the mouse button 

 
To Copy text 

¶ Select the text you want to copy. 

¶ Hold down the CTRL key 

¶ Drag to a new location 
(Note: you will see a plus sign attached to the mouse) 

¶ Release the mouse button 

¶ Release the CTRL key 
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Printing Options  
Printing options in Word 2007 are available from the Microsoft Office button.  You can 
preview, quick print one copy of the whole document or choose your own print settings.  

 
 

Exercise 8.  Print Preview Document 

¶ Click the Microsoft Office Button  

¶ Point to the arrow next to Print 

¶ Click Print Preview. 
 

 
 

Print Preview has a number of tools available to allow you to edit your document view 

Item Grouping Features 

 Print group Allows you to print from preview 

 Page setup Changes the page setup of your document 

 Zoom Changes the magnification of the document, on-screen only 

 Preview Changes the options in the preview 

  
 

4 

3 

2 
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Exercise 9.  Print specific requirements 

¶ Click the Microsoft Office Button  

¶ Click Print 

¶ Indicate settings such as Page range, 
copies and What to print 

¶ Click on OK 
 

 
 

Using the Keyboard to Print 

¶ Press CTRL+P. 
 

To print without using the dialog box 

¶ Click the Microsoft Office Button  

¶ point to the arrow next to Print  

¶ Click Quick Print. 
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 Auto Correct 
You can use the AutoCorrect feature to correct typos and misspelled words, as well as to 
insert symbols and other pieces of text. AutoCorrect is set up by default with a list of typical 
misspellings and symbols, but you can modify the list that AutoCorrect uses. 
 
Autocorrect entries will be corrected automatically as soon as you press the space bar after 
entering appropriate text. 
 

 
 

Exercise 10. Use „Auto Correct‟ Tool 

Type teh and press the spacebar 
Type adn and press the spacebar 
 
Define autocorrections using: 
cahnge   with  change 
ASAP  with  As soon As Possible 
UQL  with  University of Queensland Library 
 
Optionally, if you want to add a formatted text entry, open the document that contains the 
text that is formatted the way that you want, and select that text.  Repeat as above and the 
selected text will automatically be entered into the With box. 
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Exercise 11.  Customise AutoCorrect 

Add new text to the AutoCorrect list 

¶ Click the Microsoft Office Button  

¶ Click Word Options.  

¶ Click Proofing.  

¶ Click AutoCorrect Options. 

¶ Make sure the Replace text as you type check box is selected.  
¶ In the Replace box, type a word or phrase that you often mistype or misspell  

(for example, type usualy)  

¶ In the With box, type the correct spelling of the word 
(for example, type usually) 

¶ Click Add. 
 

To switch Autocorrect on/off  

¶ Click the Microsoft Office Button  

¶ Click Word Options 

¶ Click Proofing 

¶ Click AutoCorrect Options 

¶ To switch on, make sure the Replace text as you type check box is selected  

¶ To switch off, make sure the Replace text as you type check box is cleared 
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Auto text & Building Blocks  

 
 
Building blocks are reusable pieces of content or other document parts that are stored in 
galleries. You can access and reuse the building blocks at any time. Building blocks are 
items within a document that you save using the Quick Parts tool to be reused in other 
documents. You can also save building blocks and distribute them with templates. 
 
You can use AutoText, one type of building block, to store text or graphics that you want to 
use again, such as a standard contract clause or a long distribution list. Each selection of 
text or graphics is stored as an AutoText entry in the Building Blocks Organizer and is 
assigned a unique name that makes it easy to find the content when you want to use it. 

Exercise 12.  Create a Building Block or Quick Part  

 
Yours faithfully 
 
 
 
Your Name 
Your Job Title 
 

Creating a Building Block or Quick Part 

1. Select the content you want to 
save as a building block.  

  

 
Figure 1 The Quick Parts menu. 

 

2. Click the Insert tab and in the Text 
command set 

3. Click the down arrow next to Quick 
Parts.  

4. Click Save Selection To Quick 
Part Gallery 

Note:   The content you select can include text, images, and special formats. Whatever you save as a building 

block will be placed in the new document as is, so lines, logos, hyperlinks, and more can be saved for reuse. 
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5. The Create New Building Block 

dialog box appears. Fill in details: 
Name    

Type a unique name for the building block. 

Gallery     

Select a gallery for the building block to show up in. 

Category  

Select a category or create a new category 

Description 

Type a description of the building block 

Save in  

Select a template from the drop-down list 

Options   

Insert content in its own page building block is 

placed on a separate page.  

Insert in own paragraph for content that should 

not become part of another paragraph, even if the 

user's cursor is in the middle of a paragraph.  

Insert content only for all other content. 

 

 
Figure 2 The Create New Building Block dialog box. 

 

6. Type a name for the Quick Part 
7. Click OK.  

NOTE: This saves the new item in the Quick Parts gallery so that you can insert it in a document by selecting it 

from the Quick Parts menu. 

 

Exercise 13. Insert a Building Block or Quick Part 

Using the Ribbon  
1. Open the document in which you want to 

add the Quick Part.  
2. Click at the point in the document where 

you want to add the item.  

 
Figure 3 Available Quick Parts 

3. Click the arrow next to Quick Parts.  
4. You now see a list of building blocks you 

have added to the list.   
5. Click the part you want to insert at the 

cursor position   

Note:   If you want to see the whole collection of available building blocks, including the ones you added, click 

Building Blocks Organizer in the Quick Parts menu. A large variety of building blocks are provided for 

everything from cover pages to equations to page numbering. In the Building Blocks Organizer, you can 
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preview, edit, or delete building blocks and, if you choose, insert them in your current document. 
 
 

Using the keyboard  
1. Open the document in which you want to add the Quick Part.  
2. Click at the point in the document where you want to add the item.  
3. Type in the name of the Building Block 
4. Press function key F3 

Note:   If you do not know the name of the building block you have to insert them via the organiser.  Click 

Building Blocks Organizer in the Quick Parts menu.  
 

Exercise 14.  Edit a Building Block or Quick Part 

1. Playback the Quick Part you want to edit 
2. Make appropriate changes. 

 
Figure 4 The redefine building block dialog 

box. 

 

3. Click the arrow next to Quick Parts.  
4. Click Save Selection To Quick Part 

Gallery  
5. Re-enter the same name as the original 

Note:   You will be prompted to replace the existing 

entry 

6. Click on Yes 
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Using Help in Word  

 

 

 

 

 

 

 

 

 

 

Find the content you need in the Help window 

The way that you navigate the Help window is much the same way that you navigate the 
Web in a Web browser, such as Windows Internet Explorer. However, the Help window 
has additional features that a Web browser lacks.  
You can find Help for Microsoft Office programs in more than one place. Help is installed 
on your computer when you install an Office program, and you can get additional Help 
content from Microsoft Office Online.  
If Connected, Online appears in the lower-right corner of the Help window. If Offline 
appears in the lower-right corner, you are searching and getting Help from the files stored 
on your computer. 

 

Exercise 15.  Search the Help content on your computer 

When you are offline, you can search your local files and see the search results that Help 
finds there. When you search offline Help, additional online content is not available. 

1. In the Help window, in the Search list ,  
2. Click an option under Content from this computer.  
3. Type keywords in the search criteria list, 

4. Click Search .  
 

Exercise 16.  Switch between online and offline Help 

The Connection Status menu in the lower-right corner of 
the Help window indicates whether you are looking at Help 
online or offline. 
 

 



 
 

Notes  
 

  
 

© University of Queensland Library 2010 23 of 27 Ask I.T. Microsoft Word 2007: Level 1 
 

 Phone: (07) 3356 8811 or 1300 738 082 
 E-mail: help@askit.uq.edu.au 
 Web: http://www.library.uq.edu.au/ask-it/ 

 

To see Help on Office Online 
 
 
1. Click Show content from Office Online on the Connection Status menu in the 

lower-right corner of the Help window 

2. Type keywords in the search criteria list, and then click Search .  
 
To see Help on your computer,(offline) 

1. Click Show content only from this computer on the Connection Status menu in the 
lower-right corner of the Help window 
Note: This setting is retained after you close the Help window.  

2. Type keywords in the search criteria list, and then click Search .  
 
 

Exercise 17.  Print a Help topic 

1. Click the Microsoft Office Word Help button . 
2. Find and display the Help topic that you want.  

3. In the Help window, click Print .  
4. Select the printing options that you want, and then click Print.  
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Keyboard Shortcuts  

Working with Office Applications  
Display and use windows 

To do this  Press  

Switch to the next window.  ALT+TAB 

Switch to the previous window.  ALT+SHIFT+TAB 

Close the active window. CTRL+W or CTRL+F4 

Restore the size of the active window after you maximize it.  ALT+F5 

Move to a task pane from another pane in th e program window  F6 

Switch to the previous window.  CTRL+SHIFT+F6 

Maximize or restore a selected window. CTRL+F10 

Copy a picture of the screen to the Clipboard. PRINT SCREEN 

Copy a picture of the selected window to the Clipboard.  ALT+PRINT SCREEN 

 

Undo and redo actions 

To do this  Press  

Cancel an action. ESC 

Undo an action. CTRL+Z 

Redo or repeat an action. CTRL+Y 

 

Access and use task panes and galleries 

To do this  Press  

Move to a task pane from another pane in the program window.  F6 

Display the full set of commands on the task pane menu. CTRL+SPACEBAR 

Perform the action assigned to the selected button.  SPACEBAR or ENTER 

Open a drop-down menu for the selected gallery item.  SHIFT+F10 

Select the first or last item in a gallery.  HOME or END 

Scroll up or down in the selected gallery list.  PAGE UP or PAGE DOWN 

 

Access and use smart tags 

To do this  Press  

Display the shortcut menu for the selected item.  SHIFT+F10 

Display the menu or message for a smart tag. If more than one smart tag is 
present, switch to the next smart tag and display its menu or message.  

ALT+SHIFT+F10 

Select the next item on a smart tag menu.  DOWN ARROW 

Select the previous item on a smart tag menu.  UP ARROW 

Perform the action for the selected item on a smart tag menu.  ENTER 
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Close the smart tag menu or message. ESC 

Working with documents and Web pages 
 

Create, view, and save documents 

To do this  Press  

Create a new document of the same type as the current or most recent 
document. 

CTRL+N 

Open a document. CTRL+O 

Close a document. CTRL+W 

Split the document window.  ALT+CTRL+S 

Remove the document window split. ALT+SHIFT+C 

Save a document. CTRL+S 

 

Switch to another view 

To do this Press 

Switch to Print Layout view. ALT+CTRL+P 

Switch to Outline view. ALT+CTRL+O 

Switch to Draft view. ALT+CTRL+N 

 

Print and preview documents 

To do this  Press  

Print a document. CTRL+P 

Switch in or out of print preview.  ALT+CTRL+I 

Move around the preview page when zoomed in. Arrow keys 

Move by one preview page when zoomed out. PAGE UP or PAGE DOWN 

Move to the first preview page when zoomed out.  CTRL+HOME 

Move to the last preview page when zoomed out.  CTRL+END 

 

Full Screen Reading view 

To do this  Press  

Go to beginning of document. HOME 

Go to end of document. END 

Go to page n. n, ENTER 

Exit reading layout view. ESC 

 

Work with Web pages 

To do this  Press  

Insert a hyperlink.  CTRL+K 

Go back one page. ALT+LEFT ARROW 



 
 

Notes  
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Go forward one page. ALT+RIGHT ARROW 

Refresh. F9 

Character and paragraph formatting 
 

Copy formatting 

To do this  Press  

Copy formatting from text.  CTRL+SHIFT+C 

Apply copied formatting to text.  CTRL+SHIFT+V 

 

Change or resize the font 

To do this  Press  

Open the Font dialog box to change the font.  CTRL+SHIFT+F 

Increase the font size. CTRL+SHIFT+> 

Decrease the font size. CTRL+SHIFT+<  

Increase the font size by 1 point.  CTRL+] 

Decrease the font size by 1 point. CTRL+[ 

 

Apply character formats 

To do this  Press  

Open the Font dialog box to change the formatting of characters.  CTRL+D 

Change the case of letters. SHIFT+F3 

Format all letters as capitals. CTRL+SHIFT+A 

Apply bold formatting.  CTRL+B 

Apply an underline. CTRL+U 

Underline words but not spaces. CTRL+SHIFT+W 

Double-underline text.  CTRL+SHIFT+D 

Apply hidden text formatting.  CTRL+SHIFT+H 

Apply italic formatting.  CTRL+I 

Format letters as small capitals. CTRL+SHIFT+K 

Apply subscript formatting (automatic spacing).  CTRL+EQUAL SIGN 

Apply superscript formatting (automatic spacing).  CTRL+SHIFT+PLUS SIGN 

Remove manual character formatting. CTRL+SPACEBAR 

 

View and copy text formats 

To do this  Press  

Display nonprinting characters. (asterisk on numeric keypad does not work)  CTRL+SHIFT+*  



 
 

Notes  
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Review text formatting.  (click the text with the formatting you want to review)  SHIFT+F1  

Copy formats. CTRL+SHIFT+C 

Paste formats. CTRL+SHIFT+V 

 

Set the line spacing 

To do this  Press  

Single-space lines. CTRL+1 

Double-space lines. CTRL+2 

Set 1.5-line spacing. CTRL+5 

Add or remove one line space preceding a paragraph. CTRL+0 (zero) 

 

Align paragraphs 

To do this  Press  

Switch a paragraph between centred and left-aligned. CTRL+E 

Switch a paragraph between justified and left -aligned. CTRL+J 

Switch a paragraph between right-aligned and left-aligned. CTRL+R 

Left align a paragraph. CTRL+L 

Indent a paragraph from the left.  CTRL+M 

Remove a paragraph indent from the left.  CTRL+SHIFT+M 

Create a hanging indent. CTRL+T 

Reduce a hanging indent. CTRL+SHIFT+T 

Remove paragraph formatting. CTRL+Q 

 

Apply paragraph styles 

To do this  Press  

Open Apply Styles task pane. CTRL+SHIFT+S 

Open Styles task pane. ALT+CTRL+SHIFT+S 

Start AutoFormat. ALT+CTRL+K 

Apply the Normal style. CTRL+SHIFT+N 

Apply the Heading 1 style. ALT+CTRL+1 

Apply the Heading 2 style. ALT+CTRL+2 

Apply the Heading 3 style. ALT+CTRL+3 

 


